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Chapter 19

Miscellaneous

In This Chapter

Client Balance 
Checking Payable/Receivable Balances at the Client Level
Delivery
Bookmarks
T-Log
E-Services
Setting User Preferences

Client Balance

To quickly see the client’s balance, click the TRANSACTIONS link on the Client menu. By default, the Detail 
Assigned view on the transaction summary tab is displayed. This default setting may be changed by clicking 
on the user name found at the bottom of any Nexsure screen and clicking on the Nexsure Preferences tab 
(For more information see “Setting User Preferences” in this chapter). Click the Select View drop-down box 
and change the view to Balance Detail to show the client’s balance up to the end of the current month.

Use the [Show] link to display the search filter options. Change the Date Booked date to a future date to 
include any future activity in the balance.














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Checking Payable/Receivable Balances at the Client Level
Client balances for all policies can be accessed at the client level, which displays payable and receivable 
balances.

HOW to Access Client Payable and Receivable Amounts
After accessing the appropriate client through SEARCH, click the TRANSACTIONS link on the 
Client menu. 

By default the transaction summary tab displays.

The Select View drop-down box will default to Detail Assigned view.




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HOW and WHY Change the View
Changing the view on the transaction summary tab reveals both posted and unposted invoices, payable 
balances due and balances that have been received against an invoice as well as any payment advances or 
residuals on the client’s account.

Note: Keep in mind when changing views on the transaction summary tab, the default 
values in the [Show] filter settings will always determine what is displayed.

Detail Assigned View
In the Select View drop-down box, change the view to Detail Assigned. The Detail Assigned view 
displays the details for each invoice, both posted and unposted, along with any payments that 
have been received against that invoice for all policies for the client.

Clicking the Details  icon of a posted invoice displays the information for that invoice. A 
Reverse link is available in the navigation toolbar under the posted invoice header for reversal of 
incorrectly entered invoices.

Note: A posted invoice cannot be deleted or edited, it must be reversed and re-entered 
if incorrect.

Clicking the Details  icon of an unposted invoice displays the information for the unposted 
invoice. A Post link is available in the navigation toolbar under the invoice header and can be 
used if an invoice needs to be posted prior to the system posting date.

An asterisk * next to the invoice Status identifies a saved Internal Note. Move the pointer over 
the asterisk to display the invoice message. The Internal Note may be edited at any time by 

clicking the Details  icon of the invoice and editing the Invoice Header’s Internal Note.






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Invoice Summary View
In the Select View drop-down box, change the view to Invoice Summary. Invoice Summary 
displays both posted and unposted invoices for all policies for the client.

Clicking the Details  icon of a posted invoice displays the information for that invoice. A 
Reverse link is available in the navigation toolbar under the posted invoice header for reversal of 
incorrectly entered invoices.

Note: A posted invoice cannot be deleted or edited, it must be reversed and re-entered 
if incorrect.

Clicking the Details  icon of an unposted invoice displays the information for the unposted 
invoice. A Post link is available in the navigation toolbar under the invoice header and can be 
used if an invoice needs to be posted prior to the system posting date.

An asterisk * next to the invoice Status identifies a saved Internal Note. Move the pointer over 
the asterisk to display the invoice message. The Internal Note may be edited at any time by 

clicking the Details  icon of the invoice and editing the Invoice Header’s Internal Note.






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Assigned Payments View
In the Select View drop-down box change the view to Assigned Payments. Assigned Payments 
displays all payments that have been received and assigned to the client.

Payment Summary View
In the Select View drop-down box, change the view to Payment Summary. Payment Summary 
displays all payments that have been received along with a total of the amount received. The 
payments displayed can consist of payments applied to invoices, payment advances, residuals 
and money held on account.


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Summary View
In the Select View drop-down box, change the view to Summary View. Summary View displays 
all posted and unposted invoices along with any payments that have been received for all policies 
for the client.

Clicking the Details  icon of an unposted invoice displays the information for the unposted 
invoice. A Post link is available in the navigation toolbar under the invoice header and can be 
used if an invoice needs to be posted prior to the system posting date.

Note: A posted invoice cannot be deleted or edited, it must be reversed and re-entered 
if incorrect.

Clicking the Details  icon of a posted invoice displays the information for that invoice. A 
Reverse link is available in the navigation toolbar under the posted invoice header for reversal of 
incorrectly entered invoices.

Unposted Invoices View
In the Select View drop-down box, change the view to Unposted Invoices. All unposted invoices 
are displayed for all policies for the client.

Clicking the Details  icon of an unposted invoice displays the information for the unposted 
invoice. A Post link is available in the navigation toolbar under the invoice header and can be 
used if an invoice needs to be posted prior to the system posting date.










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Posted Invoices View
In the Select View drop-down box, change the view to Posted Invoices. All posted and unposted 
invoices will be displayed for the client.

Clicking the Details  icon of a posted invoice displays the information for that invoice. A 
Reverse link is available in the navigation toolbar under the posted invoice header for reversal of 
incorrectly entered invoices.

Note: A posted invoice cannot be deleted or edited, it must be reversed and re-entered 
if incorrect.




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Reversed Invoices View
In the Select View drop-down box, change the view to Reversed Invoices. All invoices that have 
been reversed will be displayed. 

The Invoice ID/Master Invoice ID will display the original invoice ID, the reversed invoice ID and, 
if the reversed invoice was an installment invoice, the master ID number below in parenthesis:

The number alone is the original invoice number.

A “-” displays in front of the invoice reversing the original invoice.

The master ID number displays below if the invoice was an installment invoice.

Unassigned Payments View

In the Select View drop-down box, change the view to Unassigned Payments. Any payments that 
have been received and have not been applied to an invoice will be displayed. 












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Open Binder Bill View
In the Select View drop-down box, change the view to Open Binder Bill. The summary view 
will display only open binder bill invoices. Binder bill invoicing is used to create an invoice for 
a new business policy or renewal in a bound status, before the policy and bill are received 
from the carrier. Binder bill invoicing hit the general ledger but will not appear on the agent’s 
account current statement. When the policy is received from the carrier, the binder bill will be 
reversed and a regular invoice processed. Proceed to Chapter 6 – Invoicing Binder Bill for more 
information on binder bills.

Note: Binder bill invoicing is only done on agent billed policies.


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Transactional View

The Client Receivables Aging section is located at the top of the transaction summary tab. The detail of this 
view includes posted invoices as well as all offsetting entries. The offsetting entries are:

Reconciliations

Receive Payments

Disbursements

Reversals

Notes











Page 571

Chapter 19Nexsure® Training Manual - CRM

Delivery

Nexsure Delivery provides a vehicle for outgoing communications by email or fax from the client or retail 
agent record. The Global Nexsure database of Location and Contact record email addresses and fax numbers 
is available to all users with rights to create deliveries. All client documentation is available for attachment 
to a client Delivery, eliminating the step of printing hard copies to manually fax or scan and attach to an 
external email system.  

Once sent, Deliveries are permanently documented in Nexsure.  Sent Deliveries cannot be altered, but they 
are available to re-send via either delivery method of fax or email.

The status of deliveries for the logged on user are quickly tracked from the Home menu > DELIVERY link. 
Delivery summaries display deliveries created by the logged on User unless security is granted to view 
deliveries created by all users. Home menu > DELIVERY provides access to all deliveries for all clients and 
retail agents. Client menu > DELIVERY provides access to deliveries for the selected client only. Delivery at 
policy underwriting provides access to deliveries for the selected policy only. 

Note: Staff members must be assigned to a Restricted Access policy in order to access 
policy information for deliveries or to view deliveries that contain attachments associated 
to a Restricted Access policy.

New deliveries are created from the client or retail agent record. Client deliveries can be created from 
the Client menu > DELIVERY link, marketing and policy underwriting delivery tab, posted binders and 
invoices and issued certificates. Deliveries created from the Client menu > DELIVERY link provides access 
to applications and forms of all policies, certificates, binders, verifications and other attachments without 
limitation to a specific policy, certificate or binder.

For specific information on delivering policy applications and forms, see Chapter 5, “Marketing” 
and Chapter 7, “Endorsements”.

For specific information on delivering posted invoices, see Chapter 6, “Policy”.

For specific information on delivering posted binders, see Chapter 8, “Binders”.

For specific information on delivering issued certificates, see Chapter 9, “Nexsure Certificates”.

For specific information on delivering issued verifications, see Chapter 10, “Auto ID Cards”.

HOW to Add a New Delivery from the Client Level

On the Client menu, click the DELIVERY link. The delivery summary is displayed. Saved filter 
settings will determine what is displayed on the summary. If this is the first delivery for the Client, 
no records will be found.










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Click the [Add New] link.

The delivery > email tab is displayed by default. To send a fax delivery, click the fax tab. 

The email and fax tabs are divided into two sections. E-Mail Information and fax Information 
contain sender and recipient information, a title, subject and message text box. Attachments 
of documents are added to the delivery using the Add links on the gray bars to the right of the 
Information section. All required fields are indicated by a red * asterisk under the Information 
section. 






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Enter delivery information manually or use the address book icon to access and pre-fill location 
and contact record names, email addresses and fax numbers. For information on using the 
address book, see “HOW to Use the Delivery Address Book” later in this chapter.

E-Mail Information Field Fax Information Field Description

Title Title
Title is used as an internal note and does not print on the 
delivered email or fax. Title displays on the delivery summary 
and can be used to search for deliveries.

From From

The logged on User’s name will default from their employee 
record. This is the name the recipient sees. Edit if necessary. 
The name of the User who created the delivery is saved with 
delivery details separately from the name entered here.

N/A From Fax Number
Enter your return Fax Number for the recipient’s information. 
Fax numbers do not default from employee contact records.


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E-Mail Information Field Fax Information Field Description

From E-mail Address From E-mail Address

The logged on User’s first email address saved in their employee 
record will default as the sender’s return email address. Edit 
if necessary.  Delivery status or failure notifications from the 
Nexsure server will be delivered to the inbox of the email 
address entered here.

To To
Enter the name of the recipient(s) who will receive the email 
or fax. Separate multiple names with a semicolon. 

To E-mail Address To Fax Number
Enter recipient(s) Email address(es) for an email delivery or 
Fax Number(s) for delivery via fax.  Multiple email addresses 
or fax numbers may be entered separated by a semicolon.  

CC: N/A
Enter the email address(es) of recipients to receive a copy of 
the email delivery. Separate multiple email addresses with a 
semicolon.

BCC: N/A

Enter the email address(es) of recipients to receive a blind 
copy of the email delivery. Separate multiple email addresses 
with  semicolon. Recipient addresses in the BCC field will be 
blind to all other recipients. BCC recipients are displayed in 
delivery history.

Regarding Regarding

Enter the delivery subject, as would be shown on the fax 
cover page or in the subject line of an email. The Regarding 
line displays on the recipients’ email or fax. The Regarding line 
displays on the delivery summary and can be used to search 
for deliveries.

Message Message

Enter a message for your delivery. A closing for Nexsure 
Deliveries can be saved to the employee record to default 
in the Message section of delivery information. The closing 
salutation can be saved to display the sender’s name, company 
name, phone number, confidentiality statement, etc. For 
information on how to add a default closing for Deliveries, see 
“HOW to Add an Employee Salutation” in “Employee Record 
Maintenance”, Chapter 2, Admin Training Manual.

N/A Auto Wrap While Edit 

Email delivery Messages are unlimited text fields. Fax delivery 
Messages are limited to 19 lines and 65 characters per line. 
The Auto Wrap While Edit option will display text as it will be 
displayed on the delivered fax.

Client documents can be attached to the email or fax delivery. Attachments are not required 
for a successful delivery.  To add an attachment, click the Add link to the right of the type of 
attachment on the right side of the delivery email/fax screen.





Page 575

Chapter 19Nexsure® Training Manual - CRM

The Add Delivery Attachment pop-up displays with the tab for the type of attachment selected 
displayed.

If a needed attachment is not displayed or the list is long, click the Filter [Show] link to search for 
the specific item. 

Attachment Tab Description

Policies
Click the Filter [Show] link to search for Policy Type or Policy Status other than 
In Force. Select the appropriate policy and click the Next button to display the 
policy’s forms. 




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Attachment Tab Description

Claims
Open claims display by default. Click the Filter [Show] link to search for closed 
claims or other criteria. 

Cancellations
All policies with a pending cancellation status display by default. Click the Filter 
[Show] link to search for cancelled policies or other criteria.

Invoice

All posted invoices excluding reversals display by default. Click the Filter [Show] 
link to search by other invoice statuses or other criteria. Select the invoice and 
click the Next button to display the invoice format (select non-Deluxe option to 
include Branch name and address) and invoice ID selection. 

Certificates
All issued holders display by default. Click the Filter [Show] link to search 
holders using search criteria. 

Verifications
All issued Auto IDs display by default. Click the Filter [Show] link to search for a 
specific Auto ID using search criteria.

Binders
All posted open and closed Binders display by default. Click the Filter [Show] 
link to search binders using other search criteria.

Other
All client attachments display by default. Click the Filter [Show] link to search 
for client attachments by file type or other criteria.

Preview an attachment before adding it to the delivery. To preview an attachment, locate the 
attachment on one of the available tabs. Click the blue text hyperlink to preview the document. 

Select the item or items to be attached on the displayed attachments tab. Click on other 
attachment tabs to continue selecting items for delivery. When all items are selected click the 
Attach button in the Add Delivery Attachment pop-up.

All attached items are listed under the appropriate attachment category on the right side of the 
delivery email or fax screen. Click the blue text hyperlink of an attachment name to preview prior 
to delivery. Attachments may be removed until the delivery is sent.




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When the E-Mail Information/Fax Information and any attachments are complete and ready to 
be delivered, click the [Send] link. Click [Save Draft] to save the email/fax to send at a later time. 
Clicking [Cancel] will abort the email/fax without saving any information.

Note: Once a draft has been saved or a delivery has been sent, it cannot be deleted.

After the delivery has been sent it will be available on the Client menu > DELIVERY link. While the delivery 
is processing, or unsuccessful, it will display by default on the Client menu > DELIVERY or Home menu > 
DELIVERY summary screens.


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HOW to Use the Delivery Summary Screen

Click the DELIVERY link on the Home menu or Client menu. The defaults in the [Show] filters will 
determine what displays in the summary view when clicking the DELIVERY link.

The Delivery Summary View screen displays with the status of each e-mail or fax delivery.

Delivery Summary Description

Details  Icon Click to display delivery information and print delivery details.

Paper Clip  Icon Displays the number of attachments, if any, that accompanied the delivery.

From Name/From Email
Name and email address of the person who sent the delivery as saved in the 
From and From Email Address of the delivery.

To Name/Sent to
Recipient(s) Name and the Email Address or Fax Number of the recipient as 
saved in the To fields of the delivery.

Entity Name/Created By
Name of the Client or Retail Agent associated to the delivery. Retail Agent 
delivery is identified by a Retail Agent icon to the right of the Entity Name.  
Created By identifies the User who created the delivery.

Title/Regarding Title and Regarding line of the delivery as entered by the User. 

Status Message

Deliveries with a status of Not Successful display by default. Statuses include: 
Successful, Not Successful, Processing, Processing Forms, Pending, Draft, 
Cancelled, Error Occurred. If the status appears as Not Successful, or Error 
Occurred, click the Details icon and click the [Re-Send] link. For information on 
re-sending deliveries, see “HOW to Re-Send a Delivery” later in this chapter.

Date Created/Date Delivered
Each delivery is date stamped with the date created and delivered. Times are 
shown as delivered from the Pacific Time Zone.

Via Identifies whether delivery was sent as an email or a fax.

The Details column displays an icon to determine the status of a delivery:






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Clicking the Details  icon will display the delivery details.

Note: The person logged in must be assigned to a restricted access policy to view delivery 
details that include attachments of policies, cancellations, claims or other attachments 
associated to a restricted access policy.


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Click the delivery details [Print] link to print a copy of the delivery.

Note: All delivery date and times reflect the Pacific Time Zone of the Nexsure server.

All attachments included in the delivery display on the right side of the delivery details screen 
and are summarized on the Delivery Details print view. To view or print the attachments, click the 

Magnifying Glass  icon next to the attachment on the delivery details screen.

Click the Close link to close the delivery.






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What a Successful E-mail Means
When preparing an e-mail to be sent, Nexsure generates the e-mail and submits it to the Exchange server 
to be sent. A “Successful” message is displayed when the submission is completed successfully. Since the 
e-mail has not been delivered to the recipient at this point, Nexsure verifies that the e-mail was successfully 
submitted to the Exchange server, but it cannot determine whether the e-mail address is valid or not. E-mail 
validity cannot be determined until the message is delivered and notification is received by the Exchange 
server.  Since it is the Exchange server, not Nexsure that receives this return message, the notification of 
an undeliverable address is sent from the server to the “From” address in the original e-mail. This message 
originates in the  the Exchange server that sent the message on Nexsure’s behalf as returned to the e-mail 
address specified in the “From” field on the e-mail delivery.

HOW to Use the Delivery Address Book
The Delivery Address Book can be used to search and select email addresses and business fax numbers 
found on entity location and all contact records. To use the Delivery Address Book perform the following:

On the fax or email tab, click the Address Book  icon. The address book tab is displayed. By 
default the address book tab will display the Delivery History.

Note: Previous emails sent to CC and BCC recipients are shown in the Delivery History 
with the CC or BCC notation in the Display Name column.

In the Entity list, select an entity type to search for a recipient. Respective search options will be 
displayed for each entity. The Entity list allows a search of the following entity types:




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Enter search criteria in the available search boxes. Search for Contacts assumes you are searching 
the client’s contacts. To search contact records for a carrier, click the [Clear] link to clear the 
search fields. Enter the carrier’s name in the Client search field and the word “Carrier” in the 
Entity field.

Click Search. The search results are displayed in the Search Results area.

Select the recipient’s name on the line that displays the desired delivery method, via fax or email.  
Multiple recipients may be selected at one time from search results by selecting each Display 
Name with the appropriate delivery method. When all recipients to appear in a delivery option 
are selected, click to select the From, To, CC or BCC delivery option for the selected recipients.  
Fax delivery will not offer a CC or BCC option. 

Click [Select]. The selected recipient’s name and email address for email deliveries or fax number 
for fax deliveries is added to the field selected.  If multiple recipients were selected for a field, 
their email addresses or fax numbers are separated by a semi-colon (;).

The address book stays open until all searches and selection of recipients is complete. Once all 
recipients have been added to the fax or email tab, click [Close]. The address book tab is closed.

To Send a Saved Draft

Once a draft of the email or fax has been saved, the draft can be accessed and sent at a later time.

Navigate to the saved draft by clicking SEARCH > Details  icon of the appropriate client > Client 
menu > DELIVERY or by clicking the DELIVERY link on the Home menu.

The delivery tab is displayed. Click the [Show] link and search for deliveries with a Status of Draft.












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The draft is identified by a blue Details  icon and Draft in the Status column. Click on the blue 

Details  icon. The saved email or fax draft is displayed.

Note: The number of attachments, if any, is not shown in the attachment column of the 
delivery tab. The attachments are available but will not show a count until the email or 
fax has been sent.

Make any necessary updates to the draft and click [Send].

Important: If [Cancel] is clicked at this point, the email or fax will be cancelled and cannot 
again be accessed to send. To return to the delivery tab again without sending the draft, 
click [Save Draft] to save updates or click [Close] to return to the delivery tab without 
saving changes.

HOW to Re-Send a Delivery
Deliveries that have been sent successfully and sent deliveries that have failed can be re-sent. In this 
illustration a fax that was delivered to the incorrect fax number has failed. Re-send may also be used to re-
deliver an email by fax, or re-deliver a fax by email without having to create the new delivery from scratch.

Click the Details  icon of the delivery to be re-sent.

The delivery details tab displays. Click the [Re-Send] link.








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Re-send creates a new delivery based on the content of the original delivery. The new delivery 
may be edited to correct delivery information, to change the delivery method by clicking on the 
alternate tab for fax or email, or change attachments.

Note: Re-send is not a forwarding of the original email or fax. Delivery creates a PDF 
rendering of attachments that are saved with the original delivery. Re-sending a delivery 
that includes attachments such as marketing applications will attach current versions of 
those applications. 

When the new delivery is ready to be sent, click the [Send] link. Clicking [Save Draft] will save the 
new delivery as a draft, [Print] will print the E-Mail Information, [Close] aborts the new delivery. 




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Bookmarks

Using bookmarks creates an easy way to ‘hold’ a place in Nexsure when interrupted or when the need to 
access a different screen in Nexsure arises. The user may easily return to the same screen without losing data 
that has been entered and saved. The Bookmarks link is located on the right side of the Primary menu. 

Note: Before adding a bookmark, click Save Changes or the Update link to save your 
data.

HOW to Add a Bookmark

Click the Save Changes link or Update link to save any changes that you may be making.

Click the Add link to the right of bookmarks located in the Primary menu to bookmark your page.

The item bookmarked will now be available when clicking the Expand link to the right of 
Bookmarks located in the Primary menu.

Proceed to HOW to Access a Bookmark section in this chapter.

Note: You can have an unlimited number of bookmarks.

HOW to Access a Bookmark

When you are ready to return to an item that has been bookmarked, click the Expand link to the 
right of bookmarks located in the Primary menu.

The current Nexsure screen will drop-down and display all items currently bookmarked in the top 
section of the Nexsure window, while the current place is retained in the lower portion of the 
Nexsure window.

Note: When the Expand link is clicked, the expand option changes to Hide. After accessing 
the appropriate bookmark, click the Hide link to bring the Nexsure screen back into full 
screen mode.








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Click the Flag  icon under the detail returns to the place that was bookmarked in the lower 
portion of the Nexsure window.

Click the Hide link to the right of Bookmarks located in the Primary Menu to go back to a full 
Nexsure window.

Proceed to HOW to Remove a Bookmark section in this chapter when a bookmark is no longer 
needed.

Note: Bookmarks will return the user to a policy that was bookmarked but is unable to 
bring the user back to the exact page of an application.

HOW to Remove a Bookmark

When a bookmark is no longer needed it can be removed from the list of bookmarks. Click the 
Expand link to the right of Bookmarks located in the Primary menu.

The current Nexsure screen will drop-down and display all items currently Bookmarked in the top 
section of the Nexsure window, while the current place is retained in the lower portion of the 
Nexsure window.

Click the check box in the Select column of any bookmarks that are no longer needed. 

Note: Multiple bookmarks may be selected at the same time for removal.

Click the Remove Selected link to the right of Bookmarks located in the Primary menu. 

All bookmarks selected will be removed from the Bookmarks link.



















Page 587

Chapter 19Nexsure® Training Manual - CRM

HOW to Use the Bookmark Summary Screen

Clicking the check box in the Select column of a bookmark and clicking the Remove Selected 
link to the right of Bookmarks located in the Primary menu will remove that bookmark from the 
bookmark summary view. 

Clicking the Flag  icon in the Detail column will return the user to the place that was 
bookmarked in the lower portion of the Nexsure window.

The Task column displays where the user was in Nexsure when the Add bookmark link was 
clicked

The Operation column displays what the user was doing when the Add bookmark link was 
clicked.

The Client Name column will display a clients name if the user was accessing a client when the 
Add bookmark link was clicked.

The Policy No. column will display a policy number if the user was accessing a policy when the 
Add bookmark link was clicked.

The Memo column displays a brief memo of what the user was doing when the Add bookmark 
link was clicked.

The Date Time column displays the Date and Time the bookmark was created.








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Notes
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T-Log

The T-Log (Task Log) records and generates a time stamped list of all activity on clients as well as all activity 
conducted on the agent’s Nexsure site by their employees. The T-Log may be accessed in two separate 
places, the T-LOG link on the Client menu, which displays all activity being accessed on the client, or the T-
Log tab under SETUP > Security Administration, which displays all activity conducted on the agent’s Nexsure 
site by their employees.

Note: Access to the T-Log may not be given to all employees in the agency.

HOW to Access the T-LOG Link on the Client Menu

After accessing the appropriate client through SEARCH, click the T-LOG link on the Client menu.

All activity on the client will be displayed in a summary view.

Note: The defaults in the [Show] filters will determine what is displayed in the summary 
view when clicking the T-Log link on the Client menu.

Clicking the Details  icon of an item in the T-Log will jump to that place in history.

Note: Information that is accessed by clicking the Details  icon, while it can be changed, 
cannot be saved and has no effect on the rest of the system. The T-Log is intended for 
viewing purposes only.


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HOW to Access the T-Log Tab under SETUP > Security Administration

Click the SETUP link on the Utility menu.

Click the Security Administration link in the Setup Console.

Click the T-Log tab.

All activity for the user will be displayed in a summary view.

Note: The defaults in the [Show] filters will determine what is displayed in the summary 
view when clicking the T-Log tab in setup.

Click the [Show] filter to display the search criteria, it will default to today’s date and to the User 
signed in.

Change the search criteria and click the Search button to initiate a new search.

Clicking the Details  icon of an item in the T-Log will jump to that place in history.


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Note: Information that is accessed by clicking the Details  icon, while it can be changed, 
cannot be saved and has no effect on the rest of the system. The T-Log is intended for 
viewing purposes only.

HOW to Use the T-Log Summary Screen

Clicking the Details  icon of an item in the T-Log will jump to that place in history.

The Task column displays where the user has been in Nexsure.

The Operation column displays what the user was doing relating to the task shown.

The Client Name column will display a clients name if the task and operation shown were 
concerning a client.

The Policy No. column will display a policy number, if a clients name is displayed, and the task 
and operation were concerning a clients policy.

The Memo column displays a brief memo of what the user was doing.

The User Name User Rights displays the name of the user and the security template they were 
signed in with at the time 

The Date Time column displays the Date and Time the T-Log was accessed.

Notes
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eServices

The eServices option in Nexsure provides users real-time inquiry capabilities within a carrier’s (or other 
third-party such as a MGA) secured Web site. This eliminates the need for the agency to log out of Nexsure 
or open another browser window to access the carrier’s site. Users will have access to the very latest 
information directly from the carrier’s Web site – the same information the Underwriters see. Nexsure 
eServices can includes direct links such things as:

Billing Inquiry

Policy Inquiry

Claims Inquiry

Policy Documents

Automated login is also considered an eService option. With automated login, another browser window 
is launched and the user is automatically logged into the carrier’s secured site and transfer is control to 
the carrier’s agent home page. From that point, the user can then navigate manually through the carrier 
site. Keep in mind that the active policy number from Nexsure is automatically copied to your PC clipboard 
when a carrier page is launched through Nexsure eServices. Therefore, when that policy number is needed, 
the user can just right mouse click on the policy number field in the carrier Web site and paste that policy 
number from the PC clipboard. There is no need to re-type that policy number.

The carrier information accessed through eServices will vary by carrier. Each employee of the agency, who 
has login rights to a carrier’s site, must have their login information entered in Nexsure to access eServices. In 
rare situations, where an employee may have more than one login to a carrier’s site, both should be entered 
in Nexsure. When an employee, with more than one login to a carrier’s Web site, activates eServices they 
will be prompted to select which login they would like to use upon entering the carrier’s site. 

Note: As of release of this document, there is a known issue which enables only the first 
password for use by eServices. That issue is currently being corrected. Any additional 
passwords entered will be preserved and available once the issue is corrected.

Note: The eService option is only available for in force business. It is not available for 
Opportunities or Marketing quotes.

HOW to Setup Additional Logins

Click the Organization link on the primary menu.

Click the Employees tab.

Note: It does not matter what level of the organization the employee’s additional login 
information is added to.

Click the Details  icon of the appropriate employee.

Click the additional logins tab.

Click the Add New link.


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Select carrier/third-party eService provider from the Additional Login Type drop-down menu. 

Note: If a user is unable to locate an eService provider in the Additional Login Type menu 
for which they would like to have Nexsure eServices available, feel free to e-mail Nexsure.
Support@xdti.com with the request along with the URL link to the login page for that 
carrier/provider. Such requests will be evaluated and potentially queued for future Nexsure 
releases. Providers can include most any third-party secured Web site. If the login page 
does not contain a logo for the provider, please attach the logo to the e-mail. Also indicate 
whether only automated login is desired or which other real-time inquiry functions are 
desired (billing inquiry, claims inquiry, policy inquiry, policy documents, etc.) If selected 
and deployed, this eService provider will appear in the additional login list for all Nexsure 
users (at all the Nexsure agencies).

The required fields are the Login ID, Password and Confirm Password.

Note: It is necessary to overwrite the Nexsure default Login ID with the correct Login ID 
for that carrier Web site.

The Department ID is an optional 3rd field used to collect any additional login information other 
than login id or password. (i.e. Department code, group id, producer code, etc.)

Complete the Description field, this field is optional.


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Click Save to save the additional login information. Click Cancel to abort.

Repeat the above steps to add the additional login information for all carriers for the employee.

Note: Users now have the capability to change their passwords from the primary eServices 
pop-up window. However, the first time that a particular eServices provider is added, 
that needs to be done from this Organization menu. Users that do not have rights to the 
Organization menu will need to request that eServices provider be added by their systems 
administrator.

Proceed to HOW to Access eServices section in this chapter.

HOW to Access eServices
Click the SEARCH link on the Primary menu.

Click the Details  icon of the appropriate client.

Click the Policies link in the Client menu.

Option 1

Click the Carrier’s name to launch eServices.

Option 2

Click the Details  icon of the policy

Right mouse click on the Print option on the policy detail screen and select eServices. 

Option 3

Click on the carrier names in the various Home menus (Expirations/Claims/Edits/Interface, etc).


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The eServices pop-up window is displayed.

Note: The inquiry capabilities are dependent upon each individual carrier’s Web site.

Clicking on the Auto-Login option will take the user into the carriers’ site. The active policy 
number of the client is copied to the clipboard for easy access while browsing on the carrier’s 
Web site.

Details regarding the initial eServices pop-up window shown above:

The eServices provider is selected automatically based on the carrier name or NAIC code. If the 
eServices window is not appearing for a carrier that an additional login has added, double-check 
to see that the carrier’s NAIC code(s) are listed in the carrier setup record. If this is a carrier for 
which you are currently downloading, please check with your Nexsure systems administrator 
before adding or changing NAIC codes. If Nexsure does not save the NAIC code, it is likely that 
NAIC code is already in use in your Nexsure database. In that case, check with your systems 
administrator. If the provider does not have a NAIC, match the format of the name with the name 
listed in the Additional Login Type menu. If that is a problem, please notify Nexsure Support. 

To select a different eServices provider for which an additional login has already been setup, just 
click on the drop-down box on the top of this window.

Search Web will initiate a Google™ search for the provider name.


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Update will update the password for the eServices provider for the user. The user merely types 
in the new password over the hidden password shown and clicks the Update button. If the 
user wishes to update the Login they must also enter/re-enter the Password and then click the 
Update button. This feature allows users to update their eServices additional logins if they do not 
have access to the Nexsure Organization tab. 

The Policy No field will display the active policy number from Nexsure. The policy number will 
be formatted to match what is needed by the carrier Web site. The assumed policy number 
format for the carrier is usually derived from a sample downloaded policy number from that 
carrier, if available. If policy numbers in Nexsure contain prefixes that are not used on the carrier 
Web site, this is the where they can be corrected. Users may correct the formatting of the policy 
number here before clicking Auto-Login or any of the other links. The policy number could also 
be completely overwritten in this window if the inquiry functions are needed for a policy other 
than the one active in Nexsure. The eServices pop-up window will not affect the policy numbers 
in Nexsure.

The policy Type (personal vs. commercial) selection will normally default to the correct policy 
type. In certain cases, especially when accessing eServices through the Home/Interface menu, 
the policy type is not readily available to eServices. If the incorrect policy type is displayed, the 
user can then select the correct one. The policy formatting option will change to match the policy 
type.

Other available options are listed under the eServices provider’s logo. Just click the link to access.

Note: Nexsure eServices are highly dependent upon the layout of carrier Web sites. 
Therefore, when carriers make changes to their Web sites, it is likely that eServices will 
stop prematurely. If the URL for the agent login page changes, eServices will not be 
functional until that URL is updated in a future Nexsure release. If the carrier keeps the 
login URL the same but changes the login page, it is possible that eServices will stop on 
that login page and possibly not fill in the username and/or password. These changes are 
rare but please report them promptly to Nexsure Support. If a link (billing inquiry, policy 
inquiry, etc.) does does not go as far as it went the day before or if it stops well before 
the described function, please report that to Nexsure Support as well. Your help on this 
matter is greatly appreciated. 

General Setup Considerations

Since Nexsure eServices provide automated access to real-time inquiry information from various carrier 
Web sites, Windows security setup is very important. Please see Windows XP Service Pack 2 security settings 
for further information. For each carrier Web site, enter that domain (Hartford.com, Travelers.com, Safeco.
com) as a trusted site. Do not be more specific as you will want Windows to trust all content coming from 
that carrier site. You can access this menu through Tools > Internet Options > Security. See below. 


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Privacy Tab: If pop-ups are being blocked you will need to put in the carrier domain as a site to allow pop-
ups. See below. 

Nexsure.com should also be setup as a trusted site and a site which pop-ups are allowed from. If these 
security settings are not enabled, it is likely that eServices will not be able to automatically launch any pop-
up windows once inside the carrier site and the eService will not appear to be working.
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Setting User Preferences

User preferences may be set after the user has logged into Nexsure for the Default Bill Method, (Line of 
Business) LOB Type Default and the Default Time Zone.  To change these preferences, click the User name 
link at the bottom of the Nexsure screen to bring up the contact window.

On the Contact Record dialog box, click the user preferences tab.

By default these settings are as follows:

Default Bill Method: Direct Bill

Default Transaction View: Detail Assignment

LOB Type Default: By Client Type

Default Time Zone: As set by your Org. Administrator

The Default Bill Method is the default that is populated on all new marketing records added on the policy 
info screen. Keep in mind that this is just a default and the bill method may be changed on the record as 
needed.

The Default Transaction View can be selected to default to the most used transaction view. Views available 
are: 

Assigned Payments

Balance Detail

Detail Assignment – (Default)

Invoice Summary

Open Binder Bill

Payment Summary

Posted Invoices

Reverse Invoices


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Summary View

Transactional View

Unassigned Payments

Unposted Invoices

The LOB Type Default can be set to Commercial, Personal or Client Type.  In Nexsure the client types are 
identified as either commercial or personal. If the user works mostly on personal line accounts, choosing 
personal as the default allows the quick addition of personal lines of coverage even if the client type is 
commercial. Keep in mind that this is just a default and the type may be changed as needed when adding 
lines of business to the record.

The Default Time Zone is used in Nexsure as a time stamp on work processed in Nexsure by this user. When 
this preference is changed all work will be use the selected time zone. When changing the time zone, logging 
out and back in is necessary after saving the preferences in order for the change to take effect.

Click OK to store the changes.

Notes
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